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About this guide
This section explains the notational and typographical conventions used in this documentation, and
provides a list of related documentation.

Section contents:

Typographical conventions viii

Textual conventions ix

Related documentation ix

Typographical conventions
The following table describes the typographical conventions used in this document.

Convention Description

bold text Bold text indicates:
l Graphical user interface element names (such as dialog boxes, buttons, menu
selections, and so forth).

l Command line interface commands and options.
l The name of a field, option, or parameter when used as part of an instruction.
For example: “Select the desired Inner Priority value.”

Italic text Italic text indicates:
l A text reference to the name of a field, option, or parameter.
l Document and book titles.
l The first reference to a new term.
l Special identification or emphasis in a statement.

monospace
text

Text shown in a monospace font is used to indicate:
l Text that you input. For example:
Enter cd project1

l Code samples, including keywords and variables within text and as separate
paragraphs, and user-defined program elements within text.

l Text file content or examples, such as lines of text from an .ini file.

About this guide
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Textual conventions
The following table describes the typographical conventions used in this document.

Convention Description

Boolean text Words that represent Boolean notation are written in all uppercase text.
For example: 1010 OR 1100.

Keystrokes Simultaneous keystrokes are shown by joining the key names with a plus
sign (+).
For example, CTRL+Q.

> (right angle
bracket)

Separates levels in a hierarchy of menu selections.
For example: “Select Administration > Users.”

Related documentation
Refer to the following product documentation for additional information:

l Release Notes
l All other documents in the document suite for the product

n IxNetwork Help
n IxNetwork API Guide

l Third-Party license agreements

Important! The documentation is available from the Help pull-down menu in IxNetwork.

Ixia user documentation is also available in the Support & Services > User Guides area of
https://support.ixiacom.com/. User login is required to view this online documentation.

– ix –
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CHAPTER 1 Introduction to IxNetwork
Ixia's IxNetwork is specifically targeted for the performance and functionality testing of high-speed,
high-capacity routers and switches. IxNetwork operates only on port-CPU-based test modules of Ixia.
With these modules, each test port supports an independent PowerPC running Windows and protocol
state machines.

IxNetwork provides a powerful, yet easy-to-use, graphical user interface (GUI) that you can use to
configure and run complex tests. With IxNetwork you can quickly and easily configure protocol
variables and parameters to suit a particular device under test (DUT). Combined with Ixia family of
Chassis and port-CPU-based Load Modules, you can use IxNetwork to create a test environment
tailored to your specificrequirements.

IxNetwork offers the flexibility to customize the application to meet a wide range of requirements for
testing complex network topologies, consisting of thousands of routing or switching devices. You can
emulate millions of routes and reachable hosts within the topology. You can also, easily scale the size
of the emulated topologies by adding additional test ports.

IxNetwork also provides with the ability to customize millions of traffic flows to stress the data plane
performance. You can create sophisticated configurations using powerful wizards and grid controls in

the graphical user interface. With its enhanced real-time analysis and statistics, IxNetwork is capable
of reporting comprehensive protocol status and detailed per-flow traffic performance metrics.

Features of IxNetwork
The following sections describe the features of IxNetwork:

l GUI Framework
l Enhanced Port Management
l Enhanced Protocol Configuration
l Traffic Wizard
l Test Composer
l Enhanced Statistics Reporting
l Log View Window
l Application Traffic
l Quick Tests
l Flow Tracking
l Capture Settings
l Analyzer
l Data Miner

Chapter 1  Introduction to IxNetwork
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GUI Framework
IxNetwork provides a GUI framework, with a main IxNetwork window that displays sub-windows for
Port Configuration, Protocol Configuration, Creation of QuickTests and Traffic Configuration (for L2-L3

Traffic or Application Traffic). Additional panels display Statistics and Captures. You can toggle the
Configuration and Statistics information display on and off. With this design, you can simultaneously
view

protocol configurations, statistics for traffic and protocols, and statistics information. An example of the
GUI framework is shown in the following figure.

Enhanced Port Management
IxNetwork Port Management feature allows you to assign physical ports for immediate configuration.
As an alternative, you can create a port configuration image for a port type, such as Ethernet,
withouttying up an actual physical port. You can configure protocols for this test port and save the
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resulting configuration for later use on a physical port. An example of the Port Management window
Port Selection dialog box is shown in the following figure.

Enhanced Protocol Configuration
IxNetwork supports emulation of Internet-scale routing topologies to determine the scalability limits,
and is designed to emulate a wide variety of bridging and routing protocols. Easy-to-use Protocol
Wizards allow you to quickly and precisely set up complex topologies, in a step-by-step process for
initial setup of small to large-scale test topologies across multiple Ixia ports. The wizards simplify the
setup of complex network scenarios across multiple protocols simultaneously. In addition, IxNetwork
spreadsheet GUI paradigm provides the entry, editing, and viewing of large configurations across
multipletest ports. Once you create a network topology, you can copy it easily across any supported
Ixia test port. An example of an IxNetwork configuration wizard is shown in the following figure:

BFD, L2TP, and PPPoX protocol support are present in IxNetwork. Authentication support for DHCP,
Static IP, and MAC addresses are also present. Protocol wizard is enhanced with the addition of BGP
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VPLS (Kompella Draft) to the L2 VPN wizard. Support for use of RSVP-TE and ISIS together in wizards is
added.

You can integrate previously configured protocol interfaces into Interface Groups and use in setting up
traffic configurations, with filtering based on IP version, presence of VLANs, or the type of ATM
encapsulation (in case of ATM ports). Support to protocol interfaces for Stacked VLANs (QinQ) is also
present.

Traffic Groups option is present, which you can automatically configure and display in the Traffic Group
window while configuring L2 and L3 VPNs, and Multicast VPNs (MVPNs) using the protocol wizards. You
can also manually configure Traffic Groups in the Traffic Group window. The use of Traffic Groups
simplifies the setup of traffic for complex topologies such as L2 and L3 VPNs, and MVPNs.

Chapter 1  Introduction to IxNetwork
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Traffic Wizard
The Basic Traffic Wizard and AdvancedTraffic Wizard allow you to create millions of traffic flows for
validating emulated networks and hosts. The wizards provide great flexibility to set up wire-rate traffic
streams to validate every reachable network and host.
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With the help of the Basic Traffic Wizard you can configure traffic with endpoints that have the same
encapsulation type. You can configure bi-directional traffic movement easily and quickly with the help
of the newly introduced checkbox. Multi-field tracking also can be enabled easily with the Basic Traffic
Wizard. An example of the IxNetwork Basic Traffic Wizard is shown in the following figure:

The Advanced Traffic Wizard allows to configure flexible traffic set-ups. It has the ability to support
mixed encapsulation types and allows bi-directional traffic movement. The Advanced Wizard allows to
edit and increment field values for optimized QoS testing with the help of the Packet Editor.

Flow Groups feature provides the ability to create traffic groups based on selected criteria such as
rate, frame size, and transmit properties. Unique traffic profiles can be created with the help of this
function.

An example of the IxNetwork Advanced Traffic Wizard is shown in the following figure:
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The final step of the traffic wizard is to set up the receive ports to track the traffic flows with detailed
QoS measurements of packet loss, throughput, and latency. You can track the traffic flow based on
MAC addresses, IP addresses, TOS/DSCP, MPLS labels, or custom fields. The traffic wizard also
provides optional capability for custom-editing the actual packet headers in the new version of the
Packet Editor window, such as inserting additional layers of protocol headers. Much of the packet
customization capability provided by IxExplorer of Ixia is included in the traffic wizard. An example of
the Advanced Traffic Wizard -Packet QoSEditor is shown in following figure:

Chapter 1  Introduction to IxNetwork

– 7 –



Test Composer
Test Composer is an Ixia software component, integrated into IxNetwork that permits the creation of
complex multi-step test scripts integrating events, DUT configuration commands, local or external
procedure

calls, and flow control instructions that permit branching the script flow based on a step result
evaluation.

Test scripts created using the Test Composer plug-in support multiple simultaneous connections to test
devices that can be configured using a variety of protocol interfaces: Telnet, TL1,
SSH1/SSH2/SSHAuto, CmdTool, TclSh, Raw, SNMP, Syslog, and COM.

In addition to these protocol interfaces, Test Composer scripts also support a default session of the
IxNetwork type. For this default IxNetwork session that is automatically created for every Test
Composer script, a number of pre-configured events are available for configuring Ixia chassis ports,
applying test configuration files, starting protocol traffic, launching tests, and retrieving test run
results.
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The TestComposer Online Help provides detailed information on the Test Composer window features.
Press F1 to access the online help in the Test Composer window.

Enhanced Statistics Reporting
Statistics reporting for protocols has been greatly expanded, to provide far more detailed information
about the protocol setup process. Available statistics views include port statistics, global protocol
statistics,

traffic statistics, quicktests, and individual statistic views for each of the protocols that you configure.
You can tile up to four statistic windows for simultaneous viewing. An example of the IxNetwork
Statistics window, is shown in the following figure:

Log View Window
A global LogView window provides real-time information about the status of Port Management,
Interfaces, Traffic, Test Composer, and Statistics. You can save the information in this window for later
evaluation. In addition, the PortTrace window found in IxNetwork is still available at the port level for
every protocol listed in the Protocol Window. An example of IxNetworkLogView window, showing the
progress of Port Manager, is shown in the following Figure:
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Application Traffic
The IxNetwork Traffic Wizard allows the user to create traffic flows for Layer 4 through Layer 7
Application traffic, for transmission over protocol routes, by providing a subset of the IxLoad
capabilities within IxNetwork. This subset of the IxLoad features is called IxLoadLite. Refer to the
IxLoad User Guide for additional information on the use of the IxLoadLite features.

When used for Application Traffic, the traffic wizard provides a step-by-step procedure to set up traffic
between IPv4 Application endpoints, running over routes that have been set up via one of the routing
protocols, such as BGP. Users can select which source and destination items will send and receive
traffic, how they will be mapped to each item (one-to-one or fully-meshed), and how the flows will be
generated between advertised routes (one-to-one or fully-meshed). The traffic wizard will then
automatically create fully-meshed or one-to-one application flows between all participating endpoints.
After the traffic endpoint type andsource/destination pair has been set up, an Application Traffic Profile
can be selected to emulate the Layer 4-7 scenario. An example of the traffic window for Application
Traffic is shown in the following Figure:
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Quick Tests
The Quick Tests feature allows you to use pre-defined tests.You can add, access, run, and customize
these tests according to your requirements. Step-by-step wizards allow you to set up the Quick
Tests.You can view the results of current tests, and previously run tests, and compared them in the
Results window. An example of the Quick Tests window is shown in the following figure:
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Flow Tracking
The Flow Tracking feature in the Traffic wizard allows an Ixia interface to track flows based on one or
more fields. This feature enables a Traffic window to be opened from Statistics; this view shows L2-L3
statistics for a single flow. The flow tracking settings apply to all traffic items transmitted to a
particular port. Ingress tracking by source/destination endpoint pair, egress tracking by VLAN, and
latency tracking is shown in the following figure:

Capture Settings
You can access the Capture settings by selecting Captures on the Test Configuration pane. They
control the various capture options available for both control and data packets, and allows the creation

of capture filters. You can set capture options for each port, chassis, or for each packet type.The
capture settings are shown in the following figure:
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Analyzer
Analyzer allows you to select a captured traffic stream and examine the contents of each packet in

detail.You can access this feature by clicking on the Packet Capture tab.You can save

streams and export these streams to IxNetwork's traffic controls and then re-send. The Analyzer view
is shown in the following figure:
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Data Miner
Data Miner allows you to inspect the results of an integrated test. You can access Data Miner by
clicking the Results/Reports tab. The DataMiner dialog box is shown in the following figure:
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CHAPTER 2 Installation and Licensing
The procedures explained in this chapter helps to install IxNetwork and the licenses necessary to run
IxNetwork. For more detailed information on licensing, refer to IxNetwork Licensing and the Ixia
License Management User Guide.

The topics covered in this chapter are:

l General Licensing Steps
l Chassis Installation
l IxNetwork International Language Support
l IxNetwork Installation
l Configuring IxNetwork for Silent Installation
l IxNetwork Linux Installation
l Shell Wrapper Installation
l TCL Automation Setup
l Python Automation Setup
l Perl Automation Setup
l Versions Supported by IxNetwork

Note: The minimum resolution for viewing the IxNetwork GUI is 1024x768, with a DPI setting of
Normal Size (96 DPI).

General Licensing Steps
The following steps indicate the general sequence to use when installing and licensing IxNetwork.
These steps assume that you will be installing the license server on your Ixia chassis. If you will be
using a dedicated/ standalone PC as a licensing server, see the Ixia License Management User Guide
for detailed instructions. The Ixia license installation utility is included in the IxNetwork CD build or
download file.

To avoid licensing problems, be careful as you proceed through the licensing utility program.Do not
just automatically click Next to proceed through the program, or licensing will not be successful and
you will not be able to use IxNetwork. You must read each installer screen and provide the requested
information. Although the installer takes you through the license installation process, the overview
information here is provided to ensure that you do not overlook important installation details. For more
detailed information on each step, refer to the License Management User Guide.

Important! The IxNetwork installer must be run on both the Ixia chassis and the client PC.
When the installer is run on the chassis, it installs the license server component and the
statistics engine. However, it does not install the client GUI software. When the installer is run
on the client PC, the client software is installed.

Chapter 2  Installation and Licensing

– 17 –



Note: There is a separate IxNetwork chassis installer available that is significantly faster than
the full installer. Both version can be used to install IxNetwork on the chassis.

Chassis Installation
To install an IxNetwork license onto an Ixia chassis:

1. Download IxNetwork to Ixia chassis from the Ixia Web site or the IxNetwork CD.
2. Launch the installer and answer the questions as required.
3. Once IxNetwork is installed on the chassis, licensing is installed as well.
4. If you already have a registration number and password, then launch the Ixia

Registration Utility (IRU) and register the software on the chassis. Make sure that the chassis is
connected to the Internet. If it is not, follow the offline registration steps in the License
Management User Guide.

If you do not have a registration number and password, you do not need to launch the
IRU at this time. A temporary license will be issued to you when you first attempt to run a test
from the client PC. At run time, a message appears, asking if you would like a temporary license.
Make sure that the client PC is connected to the Internet. If it is not, follow the offline temporary
license steps on the License Management User Guide.

5. Select register and follow the prompts that appear.
6. Accept the default localhostas the location for the features to be used.
7. When prompted with "Do you want the Ixia application to automatically find your license on the

chassis?", select Yes. If using a license server, follow the steps in the License Management User
Guide for registering on a license server.

8. Complete the license installation procedure by clicking Finish.

IxNetwork International Language Support
IxNetwork can be installed and run on the following language versions of each of the supported
Windows operating systems:

l US English
l Hebrew
l German
l Italian
l French
l Swedish
l Japanese
l Simplified Chinese
l Traditional Chinese
l Spanish

Note that the IxNetwork software and documentation are provided in English only.
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IxNetwork Installation
IxNetwork protocol emulation software is available for download from Ixia Web site. Licensing is now
used with IxNetwork. See General Licensing Steps, for an overview.

Important! You must have administration privileges to install IxNetwork, on both the chassis
and the client machine.

Detailed information on obtaining and installing licenses for IxNetwork is described in IxNetwork
Licensing in this guide, and in the Ixia License Management User Guide.

IxOS/IxServer and IxNetwork must be installed on the chassis prior to IxNetwork installation on the
Client PC.

There is a separate IxNetwork chassis installer available that is significantly faster than the full
installer. Both the versions can be used to install IxNetwork on the chassis. The chassis only version
provides a panel for feature selection to the users. Only the selected features are installed.

The benefits of chassis only installer are as below:

l It consumes less disk space on a chassis for storing the IxiaInstallerCache files as compared to
the Full/ main installer since we bundle only the chassis specific components/ dependencies
along with it.

l Installation is faster on a chassis due to the time saved in extracting less number of files.

To install IxNetwork, do the following:
1. Close IxServer if it is running (and if it is installed on the chassis).
2. On a Windows PC, double-click the installation.exe file to start the installation. The installation
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wizard appears as shown in the following figure:

3. Select the destination folder for installer extraction and click Next.

The Welcome dialog box appears.
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Note: To run HLTAPI scripts, you need to install an IxOS version that is compatible with the
IxNetwork version you are installing. You can install IxOS after IxNetwork installation. You need
not install IxOS if you work with HLTAPI scriptgen.

4. Click Next to go ahead with the installation. The License Agreement dialog box appears next.
5. Click I accept the terms in the license agreement to accept the license agreement. The
License Warning dialog box appears next.

6. Select the I acknowledge this message check box to proceed with the installation.

Note that if multiple versions of IxNetwork are installed on your computer, a Program
Maintenance dialog box appears.

Note: Before installing the program, you can cancel the installation by clicking Cancel. You can
then remove the existing version installed on your computer by clicking Remove.

Note: To modify the program features installed on your computer, click Modify.

Note: To repair installation errors like missing files or registry entries, click Repair.

7. Click Next to continue with the installation. The License Warning dialog box appears. BE SURE
to read the information in the License Warning window regarding license requirements.
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8. Select the I acknowledge this message check box.

Note: If you do not select the check box, the Next button is not available and the installation
cannot continue.

9. Click Next to continue the installation. The Setup Type dialog box appears, as shown in the
following figure:

10. Select one from the following:
l Typical: Click this option to install the most typical features of IxNetwork.
l Custom: Click this option to select the features you want to install.

11. The check box below this section is selected by default. When it remains selected, licensing and
anonymous usage data is sent to Ixia. To turn off data selection, clear this check box. Data
collection can be turned on or turned off any time from the 'File > Preferences > Advanced' menu.

12. Click Next to continue. If Custom setup is selected, the Custom Setup for Bundle Features
dialog box appears next, as shown in the following figure:
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13. Select the feature you want to install and click Next.

Starting with IxNetwork 7.50 EA, HLTAPI and Sample Scripts are optional features. To install
them, you must select them in the Custom Setup for Bundle Features dialog box.

If you select Documentation, the IxNetwork documents and Help files gets installed along with
the program. For windows 7 and earlier versions, these documents are available under
Advanced Information Manager located under Ixia in the Program group.

From IxNetwork 7.30, on Windows 2012 and Windows 8.1 and later versions, these documents
are available under the Docs folder in respective IxNetwork build number in the Program group.
See Accessing IxNetwork Documentation for guidance on how to access the IxNetwork help
files.

If IxOS is not installed with IxVM Server, IxVM Server Chassis feature is not selected by default.
Even if you select it, you will not be able to proceed further and a message appears informing
you that IxOS needs to installed along with IxVM Server

If you are using a server Operating System like Windows 2008 or Windows 2012, the Connection
Manager Service Installation Type dialog box appears as shown in the following figure:

Chapter 2  Installation and Licensing

– 23 –



14. Select one of the options to start the Connection Manager Service. The descriptions of the options
are as follows:

l Manual from Start Menu application shortcut

Select this option to start the Connection Manager Service manually from the Start menu.

The shortcut is available under IxNetwork. This option is selected by default.

After IxNetwork is installed, click All Programs from the Start menu of your computer.

Click IxNetwork under Ixia. Click Connection Manager to open the Connection Manager
window.

l Automatic as a windows service with no user interface

Select this option to install Connection Manager as a Windows Service which starts
automatically. It is accessible from Windows Service Manager. This option assumes that there is
no HTTP port available. To make changes to the settings, the executable needs to be run again.

l Automatic as a windows service with web user interface

Select this to install Connection Manager as a Windows Service which starts automatically.
However, in this case, the Connection Manager Settings can be managed on a web page. If you
select this option, theWeb user interface port box appears. See the following figure:
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Note: This text box is available only when Automatic as a windows service withweb user
interface is selected.

15. Type the HTTP port number in theWeb user interface port box. 8008 is specified by default.
16. Click Next. The Ready to Install the Program dialog box appears as shown in the following

figure.
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17. Click Install to proceed with the installation of the program. The Installing IxNetwork
<version number> dialog box appears displaying the progress of the installation.

18. The Ixia setup dialog box is displayed all through the installation, as shown in the following
figure. The dialog box runs in the background and verifies if the installation is including all the
items successfully.
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The installation continues automatically. Once it is complete, the Setup Completed dialog box
appears, as shown in the following figure:
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19. Select the Create Desktop shortcut? check box to create an IxNetwork icon on your desktop,
if desired.

20. Click Finish to complete the installation and reboot the system.

IxNetwork TCP Ports

Keep the TCP ports specified in the following table open for IxNetwork use:

Component Direction Port

Off Chassis HWM HWM Machine <-- > Chassis 6809

IxProxy 1080

IxNetwork TCL Wish --> TCL Sever (client) Default is 8009, user
configurable

StatViewer Client --> Chassis 9102

IxOS Client --> Chassis, File download Client -->
Chassis, Telnet

4500
23

IxLicensing

License Management Client --> Chassis SOCKS 1080

nodded service Client < -- > License Server 4501

FNP Server (lmgrd) Client --> License Server 27000- 27009

LicenseServerPlus

FNE Server Client --> License Server Client --> License
Server

Ixia Licensing Service
(RPF server)

Client --> License Server 8880

Configuring IxNetwork for Silent Installation
IxNetwork Silent Install is a feature which enables you to install IxNetwork software unattended. A
silent installation of IxNetwork is ideal for test scenarios or as part of a large-scale enterprise
deployment.

If you want to use Silent Installation to install IxNetwork software on an Ixia chassis, you must change
the policy that controls Silent Installation. See Preparing an Ixia Chassis for Silent Installation below.

IxNetwork product silent install setup is discussed in IxNetwork Silent Install using .exe Package on
the facing page.
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Preparing an Ixia Chassis for Silent Installation
If you try to run a Silent Install on an Ixia Chassis with Windows installed, Windows will display the
following warning message for the Ixia kernel driver:

Signature Not Found

To prevent this warning, you must change the Windows policy that governs the installation of unsigned
drivers. Perform the following steps. You need to perform this procedure only once.

1. On the Ixia chassis, click Start, select Run, type MMC, and click OK.
2. Click Add/Remove Snap-in, on the Console menu.
3. Click Add, select Group Policy, and click Add.
4. Click Finish / Close / OK.
5. Navigate down the following tree:

l Console Root
l Local Computer Policy
l Computer Configuration
l Windows Settings
l Security Settings
l Local Policies
l Security Options

6. Right-click unsigned driver installation behavior and click Security.
7. Change the Local policy setting to: Silently succeed.
8. Click OK.

You must reboot the chassis after this operation.

IxNetwork Silent Install using .exe Package
Setting up the silent install for IxNetwork for a chassis involves activating specific features included in
the product package, and specifying the server operation mode via a command line dialog box.

The available features and properties (operation modes) are delivered as part of the installer. Table
Features on the next page lists the features available, and Table Properties lists the properties.

To run the IxNetwork installer silently, execute IxNetwork<version><release>.exe -e command in
order to extract the exe, where <version> is the version of the software, and <release> is the release
number for the particular package. The .exe is extracted to %ProgramFiles%\
IxiaInstallerCache\IxNetwork\<full_version>folder by providing a -e switch, for example,
IxNetwork<version><release>.exe -e. The setup.exe file is located in this directory.

Perform the following steps to set up silent installation using the .exe package.

1. Open a command line window.
2. Enter the following command line argument, in one line:
setup.exe [-s|-q] [-n] [i|x|r] [F.Feature1=Yes|No [F.Feature2=Yes|No]] [P.Prop1-
1=Val1 [P.Prop2=Val2]]
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3. See IxNetwork setup.exe Package Examples below for examples of using the command line to
set up silent installation.

Note: Earlier silent installation of IxNetwork was a two step process in which you had to first
extract the setup (example: IxNetwork_8.10_EA.exe -e) and then had to provide the silent
installation switch on a command line (example: setup.exe i -s). Now you can install IxNetwork
silently using a single command line. Example: IxNetwork_ 8.10_EA.exe i -s.

Setup.exe Switches

Switch Definition

-s silent (progress bar only)

-q quiet (no GUI at all)

-n external controlled (by IxAdmin)

no switch (default) GUI installation

Setup.exe Actions

Switch Definition

i install

x uninstall

r repair

no action (default) install

Features
F.Feature1=Yes – install the named feature.

These features represent installer components and are detailed in config.xml file, in the
ConfigOptions/CannedConfig section. If no features are provided, a default configuration will be used.

Features represent the installer components that can be selected from the GUI in standalone mode.
The command line allows the combinations of these features.

Features

Feature Definition

F.Client Install Client components

F.Server Install Chassis components

F.Tcl Install Tcl components
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F.IxVM_ Chassis Install IxVM components

F. Docs Install documentation

F. OldReporter Install Legacy Reporter

F. HLTAPI Install Hltapi

F. Samples Install Samples and Scripts for IxNetwork Client

Properties
P.Prop1 =Val1 – pass to the installer a certain property.

If no properties provided, default properties are used.

Properties correspond with settings from the installation GUI, but do not represent the standard
features from the feature selection dialog box, however, the options are presented as radio buttons,
checkbox or edit fields (like the choice of TCL version in IxNetwork). A special property is InstallDir
which (if accepted by the application installer) sets the installation folder.

Properties

Property Definition

P.INSTALL_ STANDALONE Install IxNetwork

P.INSTALL_SERVER Install Chassis Components

P.INSTALL_DOCS Install Documentation

P.INSTALL_ OLDREPORTER Install Legacy Reporter

IxNetwork setup.exe Package Examples
The following examples demonstrate various options for setting up silent installation using the
setup.exe package:

l Silent installation of IxNetwork:
setup.exe –s P.INSTALL_STANDALONE=Yes

l Quiet installation of IxNetwork:
setup.exe –q P.INSTALL_STANDALONE=Yes

l Silent Uninstall (any config)
setup.exe –s x

The following table represents the detailed list of the configuration and corresponding command lines
for IxNetwork.

IxNetwork configuration to install Command line
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Install IxNetwork Silent: setup.exe –s P.INSTALL_STANDALONE=Yes
P.INSTALL_
OLDREPORTER=Yes
Quiet: setup.exe –q P.INSTALL_STANDALONE=Yes
P.INSTALL_
OLDREPORTER=Yes

Install IxNetwork and Docs Silent: setup.exe –s P.INSTALL_STANDALONE=Yes
P.INSTALL_
OLDREPORTER=Yes P.INSTALL_DOCS=Yes
Quiet: setup.exe –q P.INSTALL_STANDALONE=Yes
P.INSTALL_
OLDREPORTER=Yes P.INSTALL_DOCS=Yes

Install IxNetwork, Docs and IxVM Server
Chassis

Silent: setup.exe –s P.INSTALL_STANDALONE=Yes
P.INSTALL_
OLDREPORTER=Yes P.INSTALL_DOCS=Yes P.INSTALL_
SERVER=Yes
Quiet: setup.exe –q P.INSTALL_STANDALONE=Yes
P.INSTALL_
OLDREPORTER=Yes P.INSTALL_DOCS=Yes P.INSTALL_
SERVER=Yes

Install IxNetwork on a Physical Chassis
To install IxNetwork on a physical Ixia chassis:

1. Type IxNetworkChassis_7.40_EA.exe -e at the command line.
2. Run setup.exe -s from the extracted folder.

Uninstall/Modify a Current Installation
To remove silently or uninstall the current version of IxNetwork, enter the following argument at the
command line:

Setup.exe –s x

To modify an existing installation, first uninstall it, then reinstall it with the desired features.

Silent Repair/Modify
Silent repair is the same as running silent install on a current installation. Enter the following at the
command line:

setup.exe -s r

IxNetwork Linux Installation
The following section gives information about IxNetwork installation in Linux environment.
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Note: Root-level permission is required to run IxNetwork binary installer.

To be able to install and use IxNetwork, IxOS must be first installed on your Linux system.

To install Linux IxOS, you can choose from binary installer or tar.gz format.

Installation using IxOS Binary Installer
1. Copy the IxOS<version>Linux.bin file to the system.
2. Change the file's attribute to make it executable.

Example: chmod +x IxOS<version>Linux.bin

3. Execute the IxOS installer file (use the –i console option if installing via console or remote shell).

Example: ./IxOS<version>Linux.bin

4. When the installer prompts, select Tcl version 8.5 (required) and the install location.
5. Follow the rest of the instructions to complete the installation.

Installation using IxOS tgz Package
1. Create the destination folder.
2. Extract and copy all folders and files from the tgz package into the destination folder.

Installation/Uninstallation Commands
The installation commands are in the following mode.

1. GUI Mode:

./<Installer_name> -i gui

Example:

./IxNetworkTclClient7.50.68.514Linux.bin -i gui

./IxNetworkTclClient7.50.68.514Linux64.bin -i gui

2. Console Mode:

./<Installer_Name>

./<Installer_Name> -i console

Example:

./IxNetworkTclClient7.50.68.514Linux.bin

./IxNetworkTclClient7.50.68.514Linux.bin –i console

./IxNetworkTclClient7.50.68.514Linux64.bin

./IxNetworkTclClient7.50.68.514Linux64.bin -i console
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3. Silent Mode:

<Installer_Name> –DUSER_INSTALL_DIR=<Specify_Installation_Path> -i silent

Example – ./IxNetworkTclClient7.50.68.514Linux.bin -DUSER_INSTALL_DIRR=/

home/vmanral/ixos-3 -i silent

Uninstallation Command

The uninstallation command is given below with an example.

./<Installation_Dir>/Uninstall_<Product_Name>/Uninstall_<Product_Name>

Example – ./IxNetworkTclClient7.50.68.515-EB/ Uninstall_IxNetworkTclClient7.50.68.515/Uninstall_
IxNetworkTclClient7.50.68.515

Location of Log Files

<Users_Home_Dir>/logs

Example – /home/vmanral/logs

Note: IxOS is mandatory only during installation through GUI and Console modes. Silent
installation does not check for IxOS.

Note: During installation through GUI and Console modes, IxNetwork installation directory
should be same as the installation directory of an IxOS build and all the IxNetwork resources are
installed under lib folder of IxOS.

Installation Sequence using the Console Mode
This is the default installation mode. The steps are given below:
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Installation Sequence Using the GUI Mode
The following figure shows the initial panel in the installation sequence.

For GUI installation, perform the following steps:

1. Click Next in the Introduction dialog box of the wizard as shown in the following figure:

2. In the Choose Install Folder dialog box, select the folder location for the installer.
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3. Perform the following actions:
i. Click Choose to select a new folder location.
ii. Click Restore Default Folder to restore the default folder location.

4. Click Next, then Yes to install HLTAPI.

5. Click Next, the Pre-Installation Summary dialog box appears.
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6. Click Install.The installation progress is shown as follows:

After the installation is complete, the Install Complete dialog box appears.
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7. Click Done to exit the installation wizard.

Shell Wrapper Installation
When IxNetworkTclClient bin file is installed, shell wrappers are installed in /<install folder-
>/ixnetwork/<version>/bin folder.

l ixnettcl : Sets TCLLIBPATH and calls the ixiatcl8.5.17 link in /usr/bin. To execute Tcl script,
execute “ixnettcl <lowLevelScriptName>”

l ixnetperl : Sets PERL5LIB and calls the ixiaperl5.18 link in /usr/bin. To execute Perl script,
execute “ixnetperl < lowLevelScriptName >”

l ixnetpython : Sets PYTHONPATH and calls the ixiapython2.7.6 link in /usr/bin. To execute
Python script, execute “ixnetpython < lowLevelScriptName >”

l ixnetwish : Sets TCLLIBPATH and calls the ixiawish8.5.17 link in /usr/bin. To execute Wish script,
execute “ixnetwish < lowLevelScriptName >”

TCL Automation Setup
The ScriptGen feature of IxNetwork requires an underlying TCL platform (compiled with Thread
support). If Platform independent libraries are used, supported TCL version is 8.5. The binary installer
delivers TCL 8.5.

During installation the Tcl files are installed in /opt/ixia/tcl/<version> location.
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To run a Tcl script:

l Run the “ixnettcl <script name>” located in /<install folder>/ixnetwork/<version>/bin directory.
The script sets TCLLIBPATH and calls ixiatcl8.5.17, which is a link in /usr/bin folder that points to
ixiatcl file in /opt/ixia/tcl/<version>/bin location.

l ixiatcl file sets the other required environment variables and calls /opt/ixia/tcl/<version>/bin/tcl

The main low level automation package used by IxNetwork is called IxTclNetwork and should be
loaded upon starting the TCL interpreter using the following command:

package req IxTclNetwork.

Optionally, for running Test Composer automation, the Thread and ix_tc package need to be loaded in
this order.

Upon successful loading, it should print the IxNetwork version:

% package req IxTclNetwork
7.50.0.150
% package req Thread
2.6.5
% package req ix_tc
1.0

The binary installers create two environment variables on the system (LD_LIBRARY_PATH and
TCLLIBPATH). Both variables are appended to existing values.

l LD_LIBRARY_PATH is used to specify all the locations of the dynamic .so / .dll libraries needed
for the correct functionality of the Ixia TCL automation (.e.g. mpexpr1.0.so / mpexpr.dll for
floating point extended precision).

l TCLLIBPATH is used to provide Tcl with additional site-specific locations to search for Ixia
automation packages without installing it all the locations of the packages needed for “package
require” commands.

See TestComposer ScriptGen Tcl Reference Guide for more information.

Python Automation Setup
Python 2.7.6 comes with both Linux and Windows IxNetwork installers.

The Python version installed by IxNetworkTclClient can be accessed using the ixiapython2.7.6
command, which is a symbolic link created while installing IxNetworkTclClient. In case you have
installed multiple versions of Python on your system, the ixiapython command runs the Python
version added with the latest IxNetwork application installed.

The recommended version is python.org 2.7.6.

During installation the Python files are installed in /opt/ixia/python/<version> location.

To run a Python script:

l Run the “ixnetpython <script name>” located in /<install folder>/ixnetwork/<version>/bin
directory. The script sets PYTHON5LIB and calls ixiapython2.7.6, which is a link in /usr/bin folder
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that points to ixiapython file in /opt/ixia/python/<version>/bin location.
l ixiapython file sets the other required environment variables and calls /opt/
ixia/python/<version>/bin/python

PYTHON5LIB needs to be setup to include path to the required IxNetwork.py. To run your script using
the latest version of Python installed, use the following syntax:

ixiapython <script name>

Perl Automation Setup
Perl 5.18.1 comes with the Windows IxNetwork installer, as well as with the Linux TCL client binary
installer.

On a Linux system, the Perl version installed by IxNetwork can be accessed using the ixiaperl5.18
command, which is a symbolic link created while installing IxNetwork. In case you have installed
multiple versions of Perl, the ixiaperl command runs the highest version of Perl installed.

During installation the Perl files are installed in /opt/ixia/perl/<version> location.

To run a Perl script:

l Run the “ixnetperl <script name>” located in /<install folder>/ixnetwork/<version>/bin
directory.The script sets PERL5LIB and calls ixiaperl5.18, which is a link in /usr/bin folder that
points to ixiaperl file in /opt/ixia/perl/<version>/bin location.

l ixiaperl file sets the other required environment variables and calls /opt/
ixia/perl/<version>/bin/perl

PERL5LIB needs to be setup correctly to include path to the required IxNetwork.pm. To execute your
script using the highest version of Perl installed, use the following syntax:

PERL5LIB needs to be setup correctly to include path to the required IxNetwork.pm. To execute your
script using the highest version of Perl installed, use the following syntax:

ixiaperl <script name>

Note: PIT Notes: The Platform Independent tgz packages do not contain Perl, Python or Tcl
interpreters. The IxNetwork dependencies (mpexpr, snit, tclx) are also not included. Download
the all-in-one language packages and dependencies installer for Linux x86 and x64 to use with
any app PIT installer from the Ixia website.

Versions Supported by IxNetwork
The windows versions that are supported by the current release of IxNetwork for client machine are:

Location Supported OS versions

Client machine Windows Vista SP2 32-bit and 64-bit

Client machine Windows 2008 Enterprise SP2 32-bit
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Client machine Windows 2008 Server R2 Enterprise 64-bit

Client machine Windows 2008 Server R2 Standard 64-bit

Client machine Windows 2008 Server Standard SP2 32-bit

Client machine Windows 7 Enterprise 32-bit and 64-bit

Client machine Windows 7 Professional 32-bit and 64-bit

Client machine Windows 7 Ultimate 32-bit and 64-bit

Client machine Windows 8.1 Enterprise 32-bit and 64-bit

Client machine Windows Server 2012 R2 Standard 64-bit
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CHAPTER 3 Running a Test with IxNetwork
Follow the procedures in this guide to run a simple test and quickly gain experience with IxNetwork. If
you need to perform more advanced testing, refer to IxNetwork User Guide.

For detailed information on IxNetwork installation and licensing, see:

l Installation and Licensing

For detailed information on licensing, see:

l IxNetwork Licensing
l Ixia License Management User Guide

Following are the topics covered in this chapter:

l Requirements
l A Simple IxNetwork Test

n Connect the Ports
n Start IxNetwork
n Select the Ports
n Configure the Protocol
n Review the Protocol Configuration
n Ping the DUT
n Start the BGP Protocol
n Configure Traffic
n Set Up the Test Composer
n Set Up CSV Logging
n Set Up a QuickTest

Note: The minimum resolution for viewing the IxNetwork GUI is 1024x768, with a DPI setting of
Normal Size (96 DPI)

Requirements
IxNetwork is a client application that runs under Windows. It operates in conjunction with one or more
chassis running IxOS/IxServer.

To run the IxNetwork test in this guide, you need the following:

l An Ixia chassis with an Ethernet-based CPU-per-port load module.
l Two ports available on the load module.
l Connection cables.
l A Windows PC to run IxNetwork. The IxNetwork Client is run on the Windows workstation, while
IxOS/IxServer is run on the chassis.
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A Simple IxNetwork Test
To get acquainted with IxNetwork, perform the following steps to set up and run a simple test.

The test configuration used as an example in this document is the BGP protocol, hence, install the
IxNetwork BGP protocol emulation. Configure the Ixia ports to run the BGP protocol and send the traffic
through the DUT to Route Ranges advertised by BGP.

To run a simple test in IxNetwork, you need to perform the following steps:

1. Connect the Ports
2. Start IxNetwork
3. Select the Ports
4. Configure the Protocol
5. Review the Protocol Configuration
6. Ping the DUT
7. Start the BGP Protocol
8. Configure Traffic
9. Set Up the Test Composer
10. Set Up CSV Logging
11. Set Up a Quick Test

Connect the Ports
Before starting a test, connect the DUT ports to the Ixia chassis, using the correct cables for the
connection as shown in Ixia Chassis — DUT Cable Connections below. The PC running IxNetwork is
connected to Ixia chassis through a network connection to the management port on the chassis.

Start IxNetwork
Before you start IxNetwork:
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l Make sure IxServer is running on Ixia chassis. IxServer normally starts automatically when the
chassis boots up.

l Make sure you know the available ports on the chassis. Applications such as IxExplorer,
Scriptmate, and Tcl scripts allow you to take ownership of the ports on Ixia chassis. If the ports
are already in use, they are not available for assignment in the IxNetwork Port Management
window.

To start the IxNetwork application, perform the following tasks:

1. Double-click the IxNetwork icon on your Desktop. The IxNetwork GUI window appears as
shown in the following figure:

2. Sign in to your Ixia account to use IxNetwork. Select the Remember me check box, if you want
to store your sign in information.

Note:
l Your IxNetwork account is already created using your ixiacom.com e-mail address.
To sign in for the first time, click Forgot Password or go to
https://login.ixiacom.com/?forgot-password. Enter your e-mail address and submit
the form. You will receive an e-mail with instructions on how to proceed.

l If you do not receive an e-mail in your ixiacom.com account, click CREATE AN IXIA
ACCOUNT link or go to https://login.ixiacom.com/?create-account.
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3. Click OFFLINE, if you do not want to type any credential. In the offline mode, you will not get the
following features:

l New Ixia product releases and feature notifications
l One-click feedback and support
l Cloud config storage
l One-click config sharing

At any point of time, you can sign in to IxNetwork by clicking Not logged in in the top right
corner of the IxNetwork window. See the above screenshot for reference.

4. Click Ports on the Test Configuration pane to view the ports in use, as shown in A Simple
IxNetwork Test.

IxNetwork automatically logs you in using the local host name configured on your PC. When you select
Ixia ports for the test, IxNetwork uses this name to identify those ports as being reserved for your
exclusive use.

Select the Ports
You can make IxNetwork configurations directly on the physical ports, or create configuration images,
which you can save and apply to the ports at a later time. For this test, apply the configuration directly
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on the physical ports.

1. Click Add Ports in the Port Manager window.

The Port Selection dialog box appears, as shown in the following figure. The available ports appear in
the left pane of the window.

2. Click Add Ports to add the ports to the right pane.
3. Click OK.

The Ports window appears with a list of the newly added ports, as shown in the following figure.
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The ports are available for protocol configuration.

Configure the Protocol
Configure the protocol. For this example, use the Protocol Wizards to configure the BGP protocol on
Ixia ports.

1. On the Home tab, click Add Protocols. the Protocol Wizards dialog box appears as shown in
the following figure:

2. Click BGP/BGP+, then Run Wizard. The BGP/BGP+ Wizard - Port Select dialog box appears,
as shown in the following figure:
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The two ports that you configured are listed with their description.

3. Select the Enable check box against each port, then click Next.
4. The BGP/BGP+ Wizard - Init dialog box appears as shown in the following figure:
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5. Click Configure Topology & Generate, then click Next.

The BGP/BGP+ Wizard - Peers dialog box appears as shown in the following figure:
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6. Enable VLAN and configure the IP addressing for Ixia and DUT ports.
7. Configure the number of Ixia-emulated BGP routers per port and click Next.

The BGP/BGP+ Wizard - Route Ranges dialog box appears as shown in the following figure:

Chapter 3  Running a Test with IxNetwork

– 53 –



8. Set the BGP route ranges and select the Advertise Routes check box.
9. Click Next.

The BGP/BGP+ Wizard - Save dialog box appears, as shown in the following figure:
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10. You can save the protocol configuration for later use, or apply to the port immediately. For this
example, click Generate and Overwrite Existing Configuration.

11. Click Finish to close the dialog box and apply the protocol configuration to the ports.

Review the Protocol Configuration
The wizard automatically enables the BGP (and ARP) protocol, as shown in the following figure:
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It creates connected protocol interfaces for each port, as shown in the following figure:

It also enters the BGP protocol configuration for each of the ports, as shown in the following figure:

The emulated BGP topology is shown in the following figure:
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Ping the DUT
To ensure connectivity between Ixia ports and the device under test (DUT) ping the DUT.

1. Right-click the port and click Ping from the pop-up menu as shown in the following figure:

The Trace and StatisticsWindow appears.

2. Enter the IP address of the DUT in the Trace and Statistics Window and click Send. The received
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response appears on the Ping window as shown in the following figure:

Start the BGP Protocol
Start BGP Protocol on both the ports in the Protocol window (see Start BGP Protocol below).

1. Click Start All Protocols to start the protocols for both the ports simultaneously.

You can view the Global Protocol Statistics in the Statistics window, as shown in the following figure:

2. Verify that the BGP protocol is operating on both the ports.

Configure Traffic
You must configure a traffic for the protocol on the ports.
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1. Click Traffic Configuration on the Test Configuration pane of the IxNetwork window.

The Traffic Configuration window appears, as shown in the following figure:

2. On the Home tab, click Add Traffic ,then Advanced Traffic. The Advanced Traffic Wizard
window appears as shown in the following figure.

3. Select the One-One option for Source/Dest and Fully Meshed for Routes/Hosts from the
drop-down lists to define the Mesh Type.

4. Select the source and destination IPs in Source and Destination IP Pairs below.
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5. Click the apply icon to add the source and destination pairs in the lower pane of the window
as shown in the following figure:

6. Repeat procedures 5 and 6 to add more pairs.

As shown in Applying the Source and Destination Pairs on the previous page, traffic is sent from
the source (on the left pane) to the destination (on the right pane).

The Source/Destination Mesh type is, 'One-One.' Since two Ixia ports are being used, and
bidirectional traffic is sent between the two ports, two sources and two destinations are created.
(Each port acts as both source and destination.)

The Route Mesh type is, 'Fully Meshed'. Since there are 10 route ranges set up for each port, a
full mesh will create 100 pairs of route ranges. The Encapsulation type is non-MPLS, and the
Endpoint type is IPv4.

Creating the pairs at the high-level of the trees saves configuration time. Each port acts as both
source and destination, so the Source / Destination Pair includes 2 source items and 2
destination items. If you select individual items from the expanded tree, you must add two
Source / Destination Pairs—one for each of the two directions of traffic.

7. Click Next to continue with the configuration.
8. The Packet QoS dialog box appears, as shown in the following figure. You need not make any

changes in the dialog box.
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9. Click Next to continue with the configuration. The Flow Group Setup dialog box appears, as
shown in the following figure:

10. Select the desired Flow Group from the left navigation pane. If you select None, the default
distribution is taken for the configuration.
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11. Click Next to continue with the configuration. The Frame Setup dialog box appears, as shown in
the following figure. If required, increase the Frame Size from the default value (64).

12. Click Next to continue with the configuration.
13. The Rate Setup dialog box appears, as shown in the following figure. You can perform the rate

setup per encapsulation or for all encapsulations by clicking the relevant option. Select the
desired transmission mode (Interleaved or Sequential) and specify 10 for % Line rate.
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14. Click Next to continue with the configuration.
15. The Flow Tracking dialog box appears, as shown in the following figure. Select the desired track

flow from the Traffic Flows by navigation pane. For this example, select Source/Dest Endpoint
Pair.

Chapter 3  Running a Test with IxNetwork

– 63 –



16. Click Next to continue with the configuration.
17. The Dynamic Fields dialog box appears, as shown in the following figure. Select the MPLS Label

Values check box.

18. Click Next to continue with the configuration.

The Preview dialog box appears.

19. Click View Flow Groups/Packets in the upper right corner. The Flow Groups and Packets of
the configured Traffic Item is displayed.

20. Select a flow group. The packets for the flow group are displayed in the lower pane.
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21. Click Next to continue. The Validate dialog box appears.

22. Click Validate in the upper right corner. The result of the configured Traffic Item is displayed, as
shown in the figure.
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23. Click Finish to close the wizard.
24. Click L2-3 Traffic Items under Traffic Configuration in the Test Configuration pane.

The configured Traffic Item appears in the Traffic window, as shown in the following figure:

25. Double-click a traffic item to display the Flow Group Editor dialog box. Note that the information
in the Properties reflects the changes that were made in Frame Setup Dialog Box.

26. On the Home tab, click L2-3 Traffic, then Apply L2-3 Traffic to write the traffic configuration
to the ports. Then click Start All L2-3.
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27. View the progress of the streams in the Statistics window, as shown in the following figure:

Set Up the Test Composer
Test Composer is an Ixia software component, integrated into IxNetwork that permits the creation of
complex multi-step test scripts integrating Event Scheduler events, DUT configuration commands,
local or external procedure calls, and flow control instructions that permit branching the script flow
based on a step result evaluation.

To open the IxNetwork - Test Composer Window click the dedicated button on the
IxNetwork GUI Views tab.

The IxNetwork - Test Composer application appears as a separate panel.

The TestComposer Online Help provides detailed information on the Test Composer window features.
Press F1 to access the online help in the Test Composer window.

To set up TestComposer, do the following:
1. Click Test Composer on the Views tab to display a separate panel on the right of the

IxNetwork GUI.
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2. Click to add a new script as shown in the following figure:

See Chapter 27: Test Composer in TestComposer Online Help for details on the Test Composer Script.
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3. Click UserEvents on the Test tab to add an event as shown in the following figure:

You can define global user events and associate them with executed procedures and additional
actions.

An Execute command output or a device session to configured test devices can be monitored for the
occurrence of specified messages. When a matching message is received by either an Execute or a
Watch script step, an event is triggered and processing for the event can be configured.

See Chapter 3: Defining User Events in TestComposer Online Help for details on User Events.

Creating a Test Composer Script

See Chapter 3: Creating and Editing a Test Composer Script in TestComposer Online Help for creating
a Test Composer Script.

Creating a Sample Test Composer Script

This section describes a sample operations sequence for defining a Composer test and saving it with
the IxNetwork configuration file.
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Test Overview

For the purpose of our example, we are considering a TestComposer test script that runs against a
router DUT that is connected to an Ixia chassis port. The test starts the PPoE and DHCP protocols on
the chassis port and tests repeatedly for a steady state condition with a total number of sessions below
a configured amount no failed sessions and no sessions that are in an inconsistent state.

Initially the test script starts the protocols on the selected chassis port using the automatically created
Built-In Event session of the IxNetwork type, waits for a period of 3 minutes and then writes all
statistics to CSV files using the Write CSVs for all views command.

The resulting CSV file is opened by a CSVAnalyzer session and the Sessions_Initiated, Sessions_
Successful and Sessions_Failed statistics are retrieved into the ProtocolStats composite variable using
the CSVAnalyzer StatQuery command. The statistic values are displayed using Trace commands that
reference the composite variable retrieved previously.

The script then tests for a steady DUT condition that translates into a state whereby the number of
initiated sessions equals the sum of successful and failed sessions. In addition, this state is
characterized by a number of session lower than a configured amount, and no failed sessions. While
this condition is not met, the script loops repeatedly (using a While statement) with a 1 minute
frequency (Sleep statement),where by at each new iteration the session statistics are written anew
into CSV files, retrieved by the StatQuery function and then displayed. Inside the While loop, an If
statement tests if the initially allocated time of 15 minutes, or 900 seconds, expired, after which the
test script calls an inline logging procedure and exits using a failed condition.

Creating the Composer Test

To create the test script described in Test Overview proceed as follows:
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1. While in the TestComposer plugin, right-click the script tab and click the Properties button,
then type in a test name and an optional description in the Information window that appears.

2. Start adding the steps sequence described below.

Click the Append last Step button and add an Execute (All Protocols Start) step on the default
Built-In Event session that is created automatically for every TestComposer script. This command
starts two protocols, PPoE and DHCP, on the selected Ixia chassis port.

All Protocols Start IxN::availableItems="{::ixNet::OBJ-/eventScheduler/
availableEvents:\"REG_Start\"/availableItems/node:\"aptixia.1\"} {::ixNet::OBJ-
/eventScheduler/availableEvents:\"REG_Start\"/availableItems/node:\"aptixia.2\"}
"

3. After pausing the script execution for 3 minutes using a Sleep statement, add an Execute step
that writes all statistics to CSV files using the Write CSVs for all Views command on the Builtin
Event Session:

Statistics Write CSVs for all Views content="All Pages"
newcsvfile/overwrite=Overwrite csvfilelocation="$stat/../"

4. Add a startSession step that opens a CSVAnalyzer session to the file referenced by the $port_
stats variable:

CSVAnalyzer, startSession csvFileName="$port_stats" csvTemplateName="$stat_
template"

5. Using the previously created CSVAnalyzer session, add a statQuery step that retrieves the
aggregate Sessions_Initiated, Sessions_Succeeded, and Sessions_Failed values using
the ProtocolStats return variable assigned to the step:

StatQuery category="Statistics_1" filter=""items="{{Statistics_1.Sessions_
Initiated}
with caption:
{Sessions_Initiated} aggregation:
Sum}{{Statistics_1.Sessions_Succeeded} with caption:
{Sessions_Succeeded} aggregation:
Sum}{{Statistics_1.Sessions_Failed} with caption:
{Sessions_Failed} aggregation: Sum}"

6. Output all three variables to the screen using the Trace commands that reference the
${ProtocolStats.Statistics_1.Sessions_Failed}, ${ProtocolStats.Statistics_
1.Sessions_ Failed}, and ${ProtocolStats.Statistics_1.Sessions_Failed} variables
respectively.

7. Configure a maxtime timeout value using the following Tcl expression inside an Assign
statement:

Assign maxtime [expr [clock seconds] + 900]

8. Inside a While statement test for the steady state condition using a conditional expression that
evaluates if the number of initiated sessions equals the sum of successful and failed sessions. In
addition, the number of initiated sessions should be lower than 1000 and there should be no
failed sessions:

(${ProtocolStats.Statistics_1.Sessions_Initiated} !=
${ProtocolStats.Statistics_1.Sessions_Succeeded} +
${ProtocolStats.Statistics_1.Sessions_Failed} ) || (
${ProtocolStats.Statistics_1.Sessions_Failed}== 0 ) ||
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(${ProtocolStats.Statistics_1.Sessions_Initiated} < 1000)

9. Nested within the While loop configure an If statement to test if the time expired since test start
exceeds the initially configured amount (maxtime); while the initial time was not exceeded,
similar operations with those from steps 4, 5, and 6 are performed repeatedly with a frequency of
1 minute, with the session statistics being retrieved and displayed.

When the timeout expires, a RunProcedure statement calls the UGS-info logging procedure and
terminates the test execution using a fail status (zero value) as an argument to the Return statement.

Return 0 "Failed to start protocols in 15 minutes"

10. Click the Save button. The TestComposer script is saved into the IxNetwork configuration using
the name specified at step 1.

As part of the IxNetwork test configuration, it can then be run from the Home ribbon of IxNetwork.
When run in this mode, script-generated logs and files are can be accessed from the IxNetwork Data
Miner, while statistics exported by the script are displayed in the IxNetwork StatViewer plugin.

The script can also be run from Test Composer ribbon in the Edit or Debug mode.

Set Up CSV Logging
To set up CSV Logging, perform the following steps.

1. On the Home tab, click Test Options. The Test Options dialog box appears.
2. On the left panel, click Stat Viewer Options.
3. On the Advanced Settings tab, select the Enable CSV Logging for All Views check box.
4. Click the File tab, then Preferences. The Preferences dialog box appears.
5. On the left panel, click StatViewer Options.
6. Select the location of the CSV file. The data is saved to the CSV file path. Use the CSV

information with IxReporter to create a PDF or HTML report, or export the information to an Excel
sheet.

7. Click OK to save the settings.

Set Up a QuickTest
To set up a QuickTest, do the following:

1. Select QuickTests on the Test Configuration pane.
2. On the configuration tab, click Add QuickTests. The QuickTest window appears.
3. Select a test from the list. For this example, select RFC 2544 Throughput/Latency test.
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4. Click Next. The Ports page appears. Modify existing ports and add new ports. You can modify
existing ports only if they are unassigned (virtual) as it is assumed that any assigned ports are
already configured correctly through the Port Manager of IxNetwork. You can also add virtual
ports.

5. Click Next. The Frame Data page appears. Configure the frame data.
6. Click Next. The Traffic page appears. This page dispays the ports used in the test. You can map

source/destination ports and add them.
7. Click Next. The Traffic Options page appears. This page enables you to set various

parameters related to traffic, such as the frame sizes and delays used for the validation traffic and
the learning process parameters.

8. Click Next. The Test Parameters page appears. This page enables you to configure the
parameters for the test.

9. Click Next. The Finish page appears. This page allows to give a name to the newly configured
test.

10. Click Finish to complete the configuration.

11. Click to begin the test.
12. Select Data Miner in the Test Configuration pane. The results of the test appear in the

Results section of the Data Miner window.
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Running a Test with IxNetwork
Follow the procedures in this guide to run a simple test and quickly gain experience with IxNetwork. If
you need to perform more advanced testing, refer to IxNetwork User Guide.

For detailed information on IxNetwork installation and licensing, see:

l Installation and Licensing

For detailed information on licensing, see:

l IxNetwork Licensing
l Ixia License Management User Guide

Following are the topics covered in this chapter:

l Requirements
l A Simple IxNetwork Test

n Connect the Ports
n Start IxNetwork
n Select the Ports
n Configure the Protocol
n Review the Protocol Configuration
n Ping the DUT
n Start the BGP Protocol
n Configure Traffic
n Set Up the Test Composer
n Set Up CSV Logging
n Set Up a QuickTest

Note: The minimum resolution for viewing the IxNetwork GUI is 1024x768, with a DPI setting of
Normal Size (96 DPI)

Requirements

IxNetwork is a client application that runs under Windows. It operates in conjunction with one or more
chassis running IxOS/IxServer.

To run the IxNetwork test in this guide, you need the following:

l An Ixia chassis with an Ethernet-based CPU-per-port load module.
l Two ports available on the load module.
l Connection cables.
l A Windows PC to run IxNetwork. The IxNetwork Client is run on the Windows workstation, while
IxOS/IxServer is run on the chassis.

A Simple IxNetwork Test

To get acquainted with IxNetwork, perform the following steps to set up and run a simple test.
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The test configuration used as an example in this document is the BGP protocol, hence, install the
IxNetwork BGP protocol emulation. Configure the Ixia ports to run the BGP protocol and send the traffic
through the DUT to Route Ranges advertised by BGP.

To run a simple test in IxNetwork, you need to perform the following steps:

1. Connect the Ports
2. Start IxNetwork
3. Select the Ports
4. Configure the Protocol
5. Review the Protocol Configuration
6. Ping the DUT
7. Start the BGP Protocol
8. Configure Traffic
9. Set Up the Test Composer
10. Set Up CSV Logging
11. Set Up a Quick Test

Connect the Ports

Before starting a test, connect the DUT ports to the Ixia chassis, using the correct cables for the
connection as shown in Ixia Chassis — DUT Cable Connections below. The PC running IxNetwork is
connected to Ixia chassis through a network connection to the management port on the chassis.

Start IxNetwork

Before you start IxNetwork:

l Make sure IxServer is running on Ixia chassis. IxServer normally starts automatically when the
chassis boots up.

l Make sure you know the available ports on the chassis. Applications such as IxExplorer,
Scriptmate, and Tcl scripts allow you to take ownership of the ports on Ixia chassis. If the ports
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are already in use, they are not available for assignment in the IxNetwork Port Management
window.

To start the IxNetwork application, perform the following tasks:

1. Double-click the IxNetwork icon on your Desktop. The IxNetwork GUI window appears as
shown in the following figure:

2. Sign in to your Ixia account to use IxNetwork. Select the Remember me check box, if you want
to store your sign in information.

Note:
l Your IxNetwork account is already created using your ixiacom.com e-mail address.
To sign in for the first time, click Forgot Password or go to
https://login.ixiacom.com/?forgot-password. Enter your e-mail address and submit
the form. You will receive an e-mail with instructions on how to proceed.

l If you do not receive an e-mail in your ixiacom.com account, click CREATE AN IXIA
ACCOUNT link or go to https://login.ixiacom.com/?create-account.

3. Click OFFLINE, if you do not want to type any credential. In the offline mode, you will not get the
following features:

l New Ixia product releases and feature notifications
l One-click feedback and support
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l Cloud config storage
l One-click config sharing

At any point of time, you can sign in to IxNetwork by clicking Not logged in in the top right
corner of the IxNetwork window. See the above screenshot for reference.

4. Click Ports on the Test Configuration pane to view the ports in use, as shown in A Simple
IxNetwork Test.

IxNetwork automatically logs you in using the local host name configured on your PC. When you select
Ixia ports for the test, IxNetwork uses this name to identify those ports as being reserved for your
exclusive use.

Select the Ports

You can make IxNetwork configurations directly on the physical ports, or create configuration images,
which you can save and apply to the ports at a later time. For this test, apply the configuration directly
on the physical ports.
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1. Click Add Ports in the Port Manager window.

The Port Selection dialog box appears, as shown in the following figure. The available ports appear in
the left pane of the window.

2. Click Add Ports to add the ports to the right pane.
3. Click OK.

The Ports window appears with a list of the newly added ports, as shown in the following figure.
The ports are available for protocol configuration.
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Configure the Protocol

Configure the protocol. For this example, use the Protocol Wizards to configure the BGP protocol on
Ixia ports.

1. On the Home tab, click Add Protocols. the Protocol Wizards dialog box appears as shown in
the following figure:

2. Click BGP/BGP+, then Run Wizard. The BGP/BGP+ Wizard - Port Select dialog box appears,
as shown in the following figure:
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The two ports that you configured are listed with their description.

3. Select the Enable check box against each port, then click Next.
4. The BGP/BGP+ Wizard - Init dialog box appears as shown in the following figure:
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5. Click Configure Topology & Generate, then click Next.

The BGP/BGP+ Wizard - Peers dialog box appears as shown in the following figure:
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6. Enable VLAN and configure the IP addressing for Ixia and DUT ports.
7. Configure the number of Ixia-emulated BGP routers per port and click Next.

The BGP/BGP+ Wizard - Route Ranges dialog box appears as shown in the following figure:
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8. Set the BGP route ranges and select the Advertise Routes check box.
9. Click Next.

The BGP/BGP+ Wizard - Save dialog box appears, as shown in the following figure:
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10. You can save the protocol configuration for later use, or apply to the port immediately. For this
example, click Generate and Overwrite Existing Configuration.

11. Click Finish to close the dialog box and apply the protocol configuration to the ports.

Review the Protocol Configuration

The wizard automatically enables the BGP (and ARP) protocol, as shown in the following figure:

Chapter 3  Running a Test with IxNetwork

– 84 –



It creates connected protocol interfaces for each port, as shown in the following figure:

It also enters the BGP protocol configuration for each of the ports, as shown in the following figure:

The emulated BGP topology is shown in the following figure:
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Ping the DUT

To ensure connectivity between Ixia ports and the device under test (DUT) ping the DUT.

1. Right-click the port and click Ping from the pop-up menu as shown in the following figure:

The Trace and StatisticsWindow appears.

2. Enter the IP address of the DUT in the Trace and Statistics Window and click Send. The received
response appears on the Ping window as shown in the following figure:
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Start the BGP Protocol

Start BGP Protocol on both the ports in the Protocol window (see Start BGP Protocol below).

1. Click Start All Protocols to start the protocols for both the ports simultaneously.

You can view the Global Protocol Statistics in the Statistics window, as shown in the following figure:

2. Verify that the BGP protocol is operating on both the ports.

Configure Traffic

You must configure a traffic for the protocol on the ports.

1. Click Traffic Configuration on the Test Configuration pane of the IxNetwork window.

The Traffic Configuration window appears, as shown in the following figure:
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2. On the Home tab, click Add Traffic ,then Advanced Traffic. The Advanced Traffic Wizard
window appears as shown in the following figure.

3. Select the One-One option for Source/Dest and Fully Meshed for Routes/Hosts from the
drop-down lists to define the Mesh Type.

4. Select the source and destination IPs in Source and Destination IP Pairs below.

5. Click the apply icon to add the source and destination pairs in the lower pane of the window
as shown in the following figure:
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6. Repeat procedures 5 and 6 to add more pairs.

As shown in Applying the Source and Destination Pairs on the previous page, traffic is sent from
the source (on the left pane) to the destination (on the right pane).

The Source/Destination Mesh type is, 'One-One.' Since two Ixia ports are being used, and
bidirectional traffic is sent between the two ports, two sources and two destinations are created.
(Each port acts as both source and destination.)

The Route Mesh type is, 'Fully Meshed'. Since there are 10 route ranges set up for each port, a
full mesh will create 100 pairs of route ranges. The Encapsulation type is non-MPLS, and the
Endpoint type is IPv4.

Creating the pairs at the high-level of the trees saves configuration time. Each port acts as both
source and destination, so the Source / Destination Pair includes 2 source items and 2
destination items. If you select individual items from the expanded tree, you must add two
Source / Destination Pairs—one for each of the two directions of traffic.

7. Click Next to continue with the configuration.
8. The Packet QoS dialog box appears, as shown in the following figure. You need not make any

changes in the dialog box.
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9. Click Next to continue with the configuration. The Flow Group Setup dialog box appears, as
shown in the following figure:

10. Select the desired Flow Group from the left navigation pane. If you select None, the default
distribution is taken for the configuration.
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11. Click Next to continue with the configuration. The Frame Setup dialog box appears, as shown in
the following figure. If required, increase the Frame Size from the default value (64).

12. Click Next to continue with the configuration.
13. The Rate Setup dialog box appears, as shown in the following figure. You can perform the rate

setup per encapsulation or for all encapsulations by clicking the relevant option. Select the
desired transmission mode (Interleaved or Sequential) and specify 10 for % Line rate.
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14. Click Next to continue with the configuration.
15. The Flow Tracking dialog box appears, as shown in the following figure. Select the desired track

flow from the Traffic Flows by navigation pane. For this example, select Source/Dest Endpoint
Pair.
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16. Click Next to continue with the configuration.
17. The Dynamic Fields dialog box appears, as shown in the following figure. Select the MPLS Label

Values check box.

18. Click Next to continue with the configuration.

The Preview dialog box appears.

19. Click View Flow Groups/Packets in the upper right corner. The Flow Groups and Packets of
the configured Traffic Item is displayed.

20. Select a flow group. The packets for the flow group are displayed in the lower pane.
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21. Click Next to continue. The Validate dialog box appears.

22. Click Validate in the upper right corner. The result of the configured Traffic Item is displayed, as
shown in the figure.
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23. Click Finish to close the wizard.
24. Click L2-3 Traffic Items under Traffic Configuration in the Test Configuration pane.

The configured Traffic Item appears in the Traffic window, as shown in the following figure:

25. Double-click a traffic item to display the Flow Group Editor dialog box. Note that the information
in the Properties reflects the changes that were made in Frame Setup Dialog Box.

26. On the Home tab, click L2-3 Traffic, then Apply L2-3 Traffic to write the traffic configuration
to the ports. Then click Start All L2-3.
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27. View the progress of the streams in the Statistics window, as shown in the following figure:

Set Up the Test Composer

Test Composer is an Ixia software component, integrated into IxNetwork that permits the creation of
complex multi-step test scripts integrating Event Scheduler events, DUT configuration commands,
local or external procedure calls, and flow control instructions that permit branching the script flow
based on a step result evaluation.

To open the IxNetwork - Test Composer Window click the dedicated button on the
IxNetwork GUI Views tab.

The IxNetwork - Test Composer application appears as a separate panel.

The TestComposer Online Help provides detailed information on the Test Composer window features.
Press F1 to access the online help in the Test Composer window.

To set up TestComposer, do the following:
1. Click Test Composer on the Views tab to display a separate panel on the right of the

IxNetwork GUI.
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2. Click to add a new script as shown in the following figure:

See Chapter 27: Test Composer in TestComposer Online Help for details on the Test Composer Script.
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3. Click UserEvents on the Test tab to add an event as shown in the following figure:

You can define global user events and associate them with executed procedures and additional
actions.

An Execute command output or a device session to configured test devices can be monitored for the
occurrence of specified messages. When a matching message is received by either an Execute or a
Watch script step, an event is triggered and processing for the event can be configured.

See Chapter 3: Defining User Events in TestComposer Online Help for details on User Events.

Creating a Test Composer Script

See Chapter 3: Creating and Editing a Test Composer Script in TestComposer Online Help for creating
a Test Composer Script.

Creating a Sample Test Composer Script

This section describes a sample operations sequence for defining a Composer test and saving it with
the IxNetwork configuration file.
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Test Overview

For the purpose of our example, we are considering a TestComposer test script that runs against a
router DUT that is connected to an Ixia chassis port. The test starts the PPoE and DHCP protocols on
the chassis port and tests repeatedly for a steady state condition with a total number of sessions below
a configured amount no failed sessions and no sessions that are in an inconsistent state.

Initially the test script starts the protocols on the selected chassis port using the automatically created
Built-In Event session of the IxNetwork type, waits for a period of 3 minutes and then writes all
statistics to CSV files using the Write CSVs for all views command.

The resulting CSV file is opened by a CSVAnalyzer session and the Sessions_Initiated, Sessions_
Successful and Sessions_Failed statistics are retrieved into the ProtocolStats composite variable using
the CSVAnalyzer StatQuery command. The statistic values are displayed using Trace commands that
reference the composite variable retrieved previously.

The script then tests for a steady DUT condition that translates into a state whereby the number of
initiated sessions equals the sum of successful and failed sessions. In addition, this state is
characterized by a number of session lower than a configured amount, and no failed sessions. While
this condition is not met, the script loops repeatedly (using a While statement) with a 1 minute
frequency (Sleep statement),where by at each new iteration the session statistics are written anew
into CSV files, retrieved by the StatQuery function and then displayed. Inside the While loop, an If
statement tests if the initially allocated time of 15 minutes, or 900 seconds, expired, after which the
test script calls an inline logging procedure and exits using a failed condition.

Creating the Composer Test

To create the test script described in Test Overview proceed as follows:
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1. While in the TestComposer plugin, right-click the script tab and click the Properties button,
then type in a test name and an optional description in the Information window that appears.

2. Start adding the steps sequence described below.

Click the Append last Step button and add an Execute (All Protocols Start) step on the default
Built-In Event session that is created automatically for every TestComposer script. This command
starts two protocols, PPoE and DHCP, on the selected Ixia chassis port.

All Protocols Start IxN::availableItems="{::ixNet::OBJ-/eventScheduler/
availableEvents:\"REG_Start\"/availableItems/node:\"aptixia.1\"} {::ixNet::OBJ-
/eventScheduler/availableEvents:\"REG_Start\"/availableItems/node:\"aptixia.2\"}
"

3. After pausing the script execution for 3 minutes using a Sleep statement, add an Execute step
that writes all statistics to CSV files using the Write CSVs for all Views command on the Builtin
Event Session:

Statistics Write CSVs for all Views content="All Pages"
newcsvfile/overwrite=Overwrite csvfilelocation="$stat/../"

4. Add a startSession step that opens a CSVAnalyzer session to the file referenced by the $port_
stats variable:

CSVAnalyzer, startSession csvFileName="$port_stats" csvTemplateName="$stat_
template"

5. Using the previously created CSVAnalyzer session, add a statQuery step that retrieves the
aggregate Sessions_Initiated, Sessions_Succeeded, and Sessions_Failed values using
the ProtocolStats return variable assigned to the step:

StatQuery category="Statistics_1" filter=""items="{{Statistics_1.Sessions_
Initiated}
with caption:
{Sessions_Initiated} aggregation:
Sum}{{Statistics_1.Sessions_Succeeded} with caption:
{Sessions_Succeeded} aggregation:
Sum}{{Statistics_1.Sessions_Failed} with caption:
{Sessions_Failed} aggregation: Sum}"

6. Output all three variables to the screen using the Trace commands that reference the
${ProtocolStats.Statistics_1.Sessions_Failed}, ${ProtocolStats.Statistics_
1.Sessions_ Failed}, and ${ProtocolStats.Statistics_1.Sessions_Failed} variables
respectively.

7. Configure a maxtime timeout value using the following Tcl expression inside an Assign
statement:

Assign maxtime [expr [clock seconds] + 900]

8. Inside a While statement test for the steady state condition using a conditional expression that
evaluates if the number of initiated sessions equals the sum of successful and failed sessions. In
addition, the number of initiated sessions should be lower than 1000 and there should be no
failed sessions:

(${ProtocolStats.Statistics_1.Sessions_Initiated} !=
${ProtocolStats.Statistics_1.Sessions_Succeeded} +
${ProtocolStats.Statistics_1.Sessions_Failed} ) || (
${ProtocolStats.Statistics_1.Sessions_Failed}== 0 ) ||
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(${ProtocolStats.Statistics_1.Sessions_Initiated} < 1000)

9. Nested within the While loop configure an If statement to test if the time expired since test start
exceeds the initially configured amount (maxtime); while the initial time was not exceeded,
similar operations with those from steps 4, 5, and 6 are performed repeatedly with a frequency of
1 minute, with the session statistics being retrieved and displayed.

When the timeout expires, a RunProcedure statement calls the UGS-info logging procedure and
terminates the test execution using a fail status (zero value) as an argument to the Return statement.

Return 0 "Failed to start protocols in 15 minutes"

10. Click the Save button. The TestComposer script is saved into the IxNetwork configuration using
the name specified at step 1.

As part of the IxNetwork test configuration, it can then be run from the Home ribbon of IxNetwork.
When run in this mode, script-generated logs and files are can be accessed from the IxNetwork Data
Miner, while statistics exported by the script are displayed in the IxNetwork StatViewer plugin.

The script can also be run from Test Composer ribbon in the Edit or Debug mode.

Set Up CSV Logging

To set up CSV Logging, perform the following steps.

1. On the Home tab, click Test Options. The Test Options dialog box appears.
2. On the left panel, click Stat Viewer Options.
3. On the Advanced Settings tab, select the Enable CSV Logging for All Views check box.
4. Click the File tab, then Preferences. The Preferences dialog box appears.
5. On the left panel, click StatViewer Options.
6. Select the location of the CSV file. The data is saved to the CSV file path. Use the CSV

information with IxReporter to create a PDF or HTML report, or export the information to an Excel
sheet.

7. Click OK to save the settings.

Set Up a QuickTest

To set up a QuickTest, do the following:

1. Select QuickTests on the Test Configuration pane.
2. On the configuration tab, click Add QuickTests. The QuickTest window appears.
3. Select a test from the list. For this example, select RFC 2544 Throughput/Latency test.
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4. Click Next. The Ports page appears. Modify existing ports and add new ports. You can modify
existing ports only if they are unassigned (virtual) as it is assumed that any assigned ports are
already configured correctly through the Port Manager of IxNetwork. You can also add virtual
ports.

5. Click Next. The Frame Data page appears. Configure the frame data.
6. Click Next. The Traffic page appears. This page dispays the ports used in the test. You can map

source/destination ports and add them.
7. Click Next. The Traffic Options page appears. This page enables you to set various

parameters related to traffic, such as the frame sizes and delays used for the validation traffic and
the learning process parameters.

8. Click Next. The Test Parameters page appears. This page enables you to configure the
parameters for the test.

9. Click Next. The Finish page appears. This page allows to give a name to the newly configured
test.

10. Click Finish to complete the configuration.

11. Click to begin the test.
12. Select Data Miner in the Test Configuration pane. The results of the test appear in the

Results section of the Data Miner window.
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CHAPTER 4 Accessing IxNetwork
Documentation
The guidelines provided in this chapter help you to access the IxNetwork documentation. The
documentation set comprises of the following output formats. Click the following links to see
instructions pertaining to each format.

l PDF
l CHM
l WebHelp
l Video Tutorial

If a PDF Help File does not Open
Some of our PDF files seem to be too long or difficult for the Microsoft Internet Explorer to display
within a browser window. If this happens to you, you can adjust the settings in Adobe Acrobat to cause
it to display in a separate window. To make the adjustment, follow these steps:

1. Start Adobe Acrobat. From the Start button, select Programs Adobe Acrobat <version>. Some
versions of Acrobat are called Acrobat Reader. If your Start menu does not contain Adobe Acrobat
or Adobe Reader, then you can browse to the executable and start it directly. It should be located
at C:\Program Files\Adobe\Acrobat <version>\Acrobat\acrobat.exe.

2. Within Acrobat, select Edit...Preferences...Internet.
3. Select Options from the list on the left.
4. Clear the Display PDF in Browser check box as shown in the following figure.
5. Click OK and exit Acrobat.
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If you cannot View a CHM Help File
After you install security update 896358 or Microsoft Windows Server 2012, you may experience one or
both of the following symptoms after you click a link to an HTML Help .chm file in Internet Explorer:

l Topics in the .chm file cannot be viewed when you click Open instead of Save in the File
Download dialog box.

l Topics in the .chm file cannot be viewed when you click Save in the File Download dialog box,
and you then try to open the file.

In the File Download dialog box, click Save, and then choose where you want to save the .chm file.
Use one of the following set of instructions to view the CHM help file:

Method 1

1. Double-click the .chm file.
2. In the Open File-Security Warning dialog box, clear the Always ask before opening this
file check box.

3. Click Open.

Method 2

1. Right-click the CHM file, and click Properties.
2. Click Unblock as shown in the following figure.
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3. Double-click the .chm file to open the file.

Note: You can run applications in Windows 8.1 Enterprise for both 32-bit and 64-bit Operating
System. It will also be upgraded to SQL Server 2008 R2 SP2. All applications are compatible with
.NET 4.5.1. IxNetwork will support Active State Perl 5.18.1.

If you cannot View a WebHelp
If you are using Internet Explorer to view our WebHelp, you may not be able to view the contents.
Please configure the following browser settings before accessing the WebHelp.

1. Open the Security tab in the Internet Options dialog box from Internet Explorer Settings.
2. Click Custom level button. See figure below for illustration.

Chapter 4  Accessing IxNetwork Documentation

– 105 –



The Security Settings–Internet Zone dialog box appears.

3. Under ActiveX controls and plug-ins, click Enable against the following settings:
l Run ActiveX controls and plug-ins
l Script ActiveX controls marked safe for scripting*
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4. Click Enable against all settings under Scripting.
5. Click OK to save your settings.
6. Click OK in the Internet Options dialog box.

To View the Video Tutorials
Install the MadCap Movie Viewer to view the video tutorials. To get the latest version please visit
http://www.madcapsoftware.com/downloads/redistributables.aspx

To install the MadCap Movie Viewer:
1. Double-click SetupMadCapMovieViewer0600.msi.
2. Follow the instructions to install the movie viewer successfully.
3. Double-click the movie that you want to view.
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CHAPTER 5 IxNetwork Licensing
With IxNetwork 4.30 EA release, IxNetwork introduces a new license management system. Ixia
Licensing Utility (ILU) and License Server Plus (LS+) replace Ixia Registration Utility
(IRU) and License Server (LS) used in earlier versions of IxLicensing.

By using Ixia’s license management mechanism, you can:

l Centralize and monitor your software usage.
l Maintain an accurate license inventory.
l Smoothly transfer licenses across different hosts and teams.

The Activation Code for the purchased Ixia product(s) is sent in an e-mail message, when you
purchase an Ixia software. Enter this Activation Code in Ixia Licensing Utility to generate a license.
For the licensed software to work properly, licenses must be activated. (For activation steps, see Ixia
Licensing Management User Guide). License activation for an Ixia product can be done after the
software installation, but must be done before the software usage.

The licensing operation is done with a simple wizard and can be run in the following ways:

l The same computer on which the software was installed
l Some other Windows-based computer with the following minimum system requirements:

n Microsoft® Windows® XP, Microsoft® Windows® 7 and later
n 1 Ghz or higher processor
n 512 MB of RAM
n 950 MB of free hard drive space (x86)
n 2.1 GB of free hard drive space (x64)

The computer used to perform the licensing process must be connected to the Ixia chassis and to
workstations in the lab environment. If at all possible, it should also be connected to the Internet. If
simultaneous

connections to the lab network and Internet are not feasible, it is still possible to complete all licensing
operations. For information about the offline activation and deactivation processes, see Overview of
Offline Activation/ Deactivation section in the Ixia Licensing Management User Guide.

This chapter covers the license information for IxNetwork software in the following sections:

l IxNetwork-Specific License Information
l Types of Licenses
l Licensing Models
l Prerequisites

IxNetwork-Specific License Information
Licenses for the IxNetwork based software and protocol emulation packages for load modules are
available with separate purchase, including:
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l IxNetwork base Software, Layer 2-3 Performance Test Application, which supports traffic
generation and analysis.

l IxNetwork Protocol Emulation Bundles with multiple protocol emulations, for CPU-per-port load
modules.

l IxNetwork Protocol Emulations (individual), for CPU-per-port load modules.

To place an order, see Ordering section in the Ixia website.

Types of Licenses
Ixia provides the following types of licenses for its products:

l Node-Locked Licenses below
l Floating Licenses below
l Evaluation Licenses below

Node-Locked Licenses
Node-locked licenses are locked to a particular chassis or workstation and allow only certain product
functions to run on that chassis or workstation.

Floating Licenses
Floating licenses are stored on a license server and allow a set number of chassis or workstations to
use product software features. All chassis or workstations that use this type of license must be
connected to the license server and the server must be up and running. Once the set number of users
is reached for that particular feature, additional users for the product features are denied.

Note: You can mix both node-locked and floating licenses to get the best solution according to
your testing environment.

Evaluation Licenses
Evaluation licenses evaluate Ixia products. Except for a time limit, they act in all respects as a regular
license (must be activated using ILU).

Licensing Models
Ixia provides the following licensing models for its products:

l Subscription Licenses
l Perpetual Licenses

Subscription Licenses
Subscription licenses are floating and limited licenses, stored on a license server. They are checked
out from the defined license servers and allow only a limited number of licenses to be used
concurrently.
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Note: For specific details on subscription licenses, please refer to the documentation of your
product of interest.

Perpetual Licenses
Perpetual licenses are node-locked licenses, stored on a chassis. They are checked out from the
individual chassis and cannot be installed on a different license server.

Note: For specific details on perpetual licenses, please refer to the documentation of your
product of interest.

Prerequisites
Before activating a license, you must have the following:

l The e-mail message from Ixia with the activation code. The key contents of this e-mail message
are as follows:

n Activation Code: A unique number for the license.
n Quantity: The number of licenses.
n Product: The product for which the license is activated.
n Start Date: The date from which the license can be activated.
n End Date: The date on which the license will expire.
n Entitlement Code: If you provide the entitlement code, ILU loads all the available activation
codes associated with that entitlement code.

For Licensing Scenarios and guidance for installing Ixia Licensing Utility, see Ixia Licensing
Management User Guide.

AppLibrary Licensing
AppLibrary supports counted licensing with subscription. The software license is counted by the
number of cards for the chassis, but is able to float across any card in the chassis that supports the
feature (node locked to the chassis).

On its application, it is counted per node and is floating across appliances. A single AppLibrary license
enables the feature on a single appliance.

Note: AppLibrary license enables subscription valid for a year from purchase. Once expired, the
feature can continue to be used; however, it is not entitled to new updates.
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